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ЗАСТОСУВАННЯ ПАКЕТУ R ДЛЯ ЧИСЕЛЬНОГО МОДЕЛЮВАННЯ 

РЕШІТЧАСТИХ ЗОБРАЖЕНЬ ФЛУОРЕСЦІЮЮЧИХ ПІКСЕЛІВ  

В КІБЕРФІЗИЧНИХ БІОСЕНСОРНИХ СИСТЕМАХ 
 
В роботі проведено комп’ютерне моделювання решітчастих зображень флуоресціюючих пікселів в 

кіберфізичній біосенсорній системі на гексагональній решітці з використанням диференціальних рівнянь із 
запізненням за допомогою пакета R. Предметом дослідження є кіберфізична біосенсорна система на 
гексагональній решітці з використанням диференціальних рівнянь із запізненням. Метою роботи є дослідження 
решітчастих зображень флуоресціюючих пікселів в кіберфізичній біосенсорній системі на гексагональній решітці з 
використанням диференціальних рівнянь із запізненням за допомогою пакета R. Реалізовано комп’ютерну 
програму «Комп'ютерне моделювання решітчастих зображень флуоресціюючих пікселів в кіберфізичній 
біосенсорній системі на гексагональній решітці з використанням диференціальних рівнянь із запізненням». 
Проведено комп’ютерне моделювання досліджуваної моделі, наведено параметри моделі, їх числові значення, а 
також представлено параметри в пакеті R. Проаналізовано останні дослідження, які стосуються біосенсорів та 
імуносенсорів, їх видів, та популярність наукових напрямів дослідження протягом останніх років. Незважаючи на 
величезну різноманітність сучасних фізико-хімічних методів детектування аналітичного сигналу в імуноаналізі 
найбільш широко використовуються електрохімічні методи, які мають низку незаперечних переваг: висока 
чутливість і точність, селективність і експресність, невисоку собівартість та універсальність. Описано пакет R 
як середовище програмування для статистичного аналізу даних із заданими значеннями параметрів моделі 
біосенсора на гексагональній решітці з використанням диференціальних рівнянь із запізненням. Наведені 
посилання на корисні сайти та рекомендації по роботі з пакетом R. Результати решітчастих зображень 
флуоресціюючих пікселів в кіберфізичній біосенсорній системі на гексагональній решітці з використанням 
диференціальних рівнянь із запізненням дають змогу провести дослідження стійкості моделі біосенсора. За 
отриманими результатами чисельного моделювання встановлено, що її якісна поведінка суттєво залежить від 
часу запізнення. 
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APPLICATION OF PACKAGE R FOR NUMERICAL SIMULATION OF LATTICE IMAGES  

OF FLUORESCENT PIXELS IN CYBER-PHYSICAL BIOSENSOR SYSTEMS 
 

The computer simulation of lattice images of fluorescing pixels in a cyberphysical biosensor system on a hexagonal lattice using 
delayed differential equations using R. The subject of the study is a cyberphysical biosensor system with hexagonal zoning. The aim of this 
study is to study lattice images of fluorescent pixels in a cyberphysical biosensor system on a hexagonal lattice using delayed differential 
equations using the R package. The computer program "Computer simulation of fluorescence pixel lattice images in a cyberphysical 
biosensor system on a hexagonal lattice using delayed differential equations" is implemented. The computer simulation of the studied model 
is made, the model parameters, their numerical values are presented, and the parameters are presented in the package R. The recent 
researches concerning the biosensors and immunosensors, their types and the popularity of scientific directions of the research in recent 
years are analysed. Despite the huge variety of modern physic-chemical methods for detecting the analytical signal in immunoassay, 
electrochemical methods are widely used, with a number of indisputable advantages: high sensitivity and precision, selectivity and 
expressiveness, not high cost and versatility. The package R is described as a programming environment for statistical analysis of data with 
setpoints of the biosensor model parameters on a hexagonal lattice using delayed differential equations. Here are links to useful sites and 
recommendations for working with R package. The results of the lattice images of fluorescing pixels in a cyber-physical biosensor system on a 
hexagonal lattice using delayed differential equations make it possible to study the stability of the biosensor model. The numerical simulation 
results show that its qualitative behaviour is significantly dependent on the delay time. 
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Вступ 

Кіберфізична система (КФС) – фізична система, яка реалізує інтеграцію обчислень та фізичних 

процесів. Такі системи найчастіше спостерігаються у вигляді вбудованих систем та мереж для моніторингу 

та контролю фізичних процесів у системах зі зворотним зв’язком. У таких системах динаміка фізичних 

процесів є джерелом інформації досліджуваного явища з можливістю контролю та розрахунку сигналів 

керування об’єктом [1].  

Кіберфізичні системи ототожнюються з проявом четвертої промислової революції, яка відбувається 

в сучасному світі [2]. Таким чином існує також фізична можливість використання технологій «Internet of 

Things (Інтернет речей)», де необхідно використовувати сигнали від давачів і вимірювальних приладів. Таким 

чином, у літературі з’являється все більше публікацій [3], які привертають увагу до сучасних концепцій та 

пропонують нові інноваційні рішення. А. Платцер запропонував підхід на основі «динамічної логіки», де 

описано та проаналізовані кібер-фізичні системи [4]. У цих роботах використовуються гібридні програми 

(ГП) простою мовою програмування з простою семантикою. ГП дають змогу програмісту звертатись 

безпосередньо до дійсних значень змінних, які представляють реальні величини і визначають їх динаміку. 

Мета дослідження. Провести комп’ютерне моделювання решітчастих зображень флуоресціюючих 

пікселів в кіберфізичній біосенсорній системі на гексагональній решітці з використанням диференціальних 

рівнянь із запізненням. 

Аналіз останніх досліджень 

 Важливим етапом проектування КФС є створення їх математичних моделей, які б адекватно 

відображали важливі, з точки зору задач дослідження, сторони просторово-часової структури імуносенсорів. 

Якість математичної моделі біосенсора суттєво визначає ефективність методів його обробки в КФС, 

зумовлює рівень інформативності та репрезентативності діагностичних ознак, та зумовлює структуру 

програмної та апаратної складових проектованої інформаційної системи. 

Біосенсори відносяться до аналітичних пристроїв для якісного і кількісного аналізу біологічних 

компонентів проб, засновані на виявленні специфічних антигенів та антитіл за допомогою імунокомплексів.  

Біосенсори, що розробляються і розроблені до теперішнього часу, як правило, використовують 

гетерогенний формат біоаналізу. Ґрунтуючись на характері механізму детектування, біосенсори можуть 

бути розділені на електрохімічні, оптичні, п'єзоелектричні та ін. Для кожного типу характерні певні 

переваги і недоліки, що призводить до великої кількості досліджень з розробки біосенсорів [5]. 

Незважаючи на величезну різноманітність сучасних фізико-хімічних методів детектування 

аналітичного сигналу в біоаналізі переважають електрохімічні методи, які мають низку незаперечних 

переваг: висока чутливість і точність (завдяки унікальному поєднанню специфічної взаємодії антиген-

антитіло і чутливої електрохімічної детекції), селективність і експресність, не висока собівартість і 

універсальність. 

Слід зазначити, що основним компонентом всіх біосенсорів є рецепторний шар, що представляє 

собою антигени, монополіклональні антитіла, або їх фрагменти, певним чином нанесені на робочу поверхню 

трансдьюсера. Одна з проблем, пов'язана з ефективністю сендвіч-аналізу, на основі антитіл, полягає в 

можливості взаємодії не тільки з визначеними антитілами, а й іншими імуноглобулінами, що утворюються 

при різних системних захворюваннях. Ці білки знаходяться в 40% сироватки здорових пацієнтів і можуть 

призводити до хибних позитивних результатів аналізу. У пошуках альтернативних антитіл, застосовують 

фрагменти антитіл, аптамери і білкові каркаси неімуноглобулінів [6–8]. Альтернативні молекули повинні 

задовольняти ряду вимог, а саме: їх необхідно швидко і недорого виготовляти, повинні бути стабільні в 

різних умовах, мати тривалий термін зберігання. При цьому «замінники» антитіл повинні володіти 

необхідною чутливістю і специфічністю [9]. Фрагменти антитіл, що володіють високою специфічністю для 

їх цільового аналіту, здатністю підтримувати розпізнавання антигену, невеликими розміри, в порівнянні з 

повним антитілом, більш застосовні для іммобілізації, ніж наявні природно сформовані антитіла, і стають 

важливими інструментами в дослідженні і створенні імуносенсора [10].  

У роботі [11] проведено порівняльний аналіз електрохімічних біосенсорів з іммобілізованими 

антитілами чотирма різними способами (фізичної сорбції, ковалентного зв'язування з застосуванням 

глутарового альдегіду, ковалентного зв'язування з застосуванням IgG людини і протеїну А). Проведені 

випробування показали, що найкращими аналітичними характеристиками володіє останній тип сенсорів. 

Біосенсор повинен бути багаторазовим пристроєм, оскільки оборотність взаємодії антиген – 

антитіло може дозволити регенерувати іммобілізований компонент. Однак висока константа афінності і 

проблема часто необхідних досить «суворих» умов іммобілізації антитіла або антигену роблять регенерацію 

поверхні важкою для реалізації, тим самим обмежуючи практичне застосування біосенсорів [12]. 

Виклад основного матеріалу. 

Пакет R як середовище програмування для статистичного аналізу даних 

Пакет R  це середовище програмування для статистичного аналізу даних, яке складається з базової 

програми R, що працює як інтерпретатор мови статистичного програмування S, та окремих пакетів, які 

реалізують спеціальні методи та технології статистичної обробки даних. Програма R є некомерційною і 

вільно розповсюджується за умови дотримання вимог GNU General Public License [13]. 

Пакет R застосовується скрізь, де потрібна робота з даними. Це не тільки статистика в вузькому 

сенсі слова, а й «первинний» аналіз (графіки, таблиці спряженості), а також сучасне математичне 
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моделювання. Дана програма також використовується як альтернатива комерційним програмним 

середовищам аналізу даних рівня MatLab / Octave. З іншого боку, цілком природно, що основна 

обчислювальна потужність R найкраще проявляється при статистичному аналізі: від обчислення середніх 

величин до вейвлет-перетворень тимчасових рядів. 

Додаткової популярності R дало створення системи зберігання і розповсюдження пакетів – CRAN 

(Comprehensive R Archive Network — http://cran.r-project.org) [14]. Статистичні алгоритми зазвичай 

виконуються у вигляді скриптів і зібрані у пакети (packages) R. Під час інсталяції разом з базовою 

програмою інсталюються й основні пакети, у яких реалізовано найбільш популярні методи статистичного 

аналізу. Частина цих пакетів автоматично завантажується під час запуску R. Інші пакети можна 

завантажити, використовуючи функцію library. 

Переваги пакета R: 

– пакет R є вільно поширюваним програмним забезпеченням (будь-хто може його безкоштовно завантажити 

з сайту http://www.r-project.org); 

– є реалізації під операційні системи Microsoft Windows, Mac OS X, Linux; 

– базова комплектація R займає небагато місця на диску і містить усі функції, необхідні для проведення 

статистичного аналізу; 

– завжди можна додатково встановити допоміжні пакети; 

– хороша графічна візуалізація подання даних та результатів їхнього аналізу; 

– можливість самостійного написання необхідних функцій. 

Робота з пакетом R 

Після відкриття програми пакет R x64 3.5.2 з’являється її головна сторінка (рис. 1).  
 

 
 

Рис. 1. Головна сторінка програми програми пакету R x64 3.5.2 
 

У верхній частині вікна знаходиться головне меню, а нижче відкрито вікно «консолі  R», в якій 

можна давати інструкції програмі та отримувати її відповіді. Синім кольором у цьому вікні виведено 

початкову інформацію про версію базової програми R. Червоний символ  >  є запрошенням користувачу 

вводити власні інструкції.  

При роботі з R можна виконувати одразу багато інструкцій, що записані в окремому файлі. 

Найпростіший спосіб зробити – це завантажити такий файл, в якому-небудь текстовому редакторі, 

скопіювати, а потім вставити на консолі. При цьому, якщо інструкції у файлі розміщені у окремих рядках, 

розділових знаків між ними не потрібно. Інструкції, вміщені в одному рядку, розділяють символом «крапка 

з комою». Якщо довга інструкція не вміщується у одному рядку, її можна розбити на декілька рядів, 

причому, при переході до наступного рядка R автоматично виводить символ продовження +.  R сам 

здогадується, що інструкція не закінчена за її синтаксисом. Тому деякі синтаксичні помилки (наприклад, 

забуті дужки) можуть сприйматись як незакінчені інструкції. У цьому випадку R присвоїть + на початку 

наступного рядка і перейде у режим очікування. Натиснувши Еscape можна перейти у режим введення нової 

інструкції без продовження аналізу попередньої. Програми, що складаються з інструкцій R, називають 

скриптами (script). Вони мають стандартне розширення .r.  У базовій програмі є можливість відкрити вікно 

редактора для створення нового скрипту, або завантажити файл зі скриптом, використовуючи пункти 

головного меню File->Newscript або File->Openscript. Виконати завантажений у вікні редактора скрипт 

повністю можна, використовуючи  Edit->Runall. 

Зберегти скрипт можна за допомогою команди File>Save. 
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Пакети в R 

Однією з важливих переваг R є наявність для нього різноманітних розширень або пакетів, які 

реалізують найбільш популярні технології статистичної обробки [15]. Частина цих пакетів автоматично 

завантажується при запуску R. 

Якщо потрібний пакет не було інстальовано на комп’ютері, його можна завантажити з інтернет-

архіву, використовуючи пункти головного меню Packages->Installpackage(s). Спочатку програма пропонує 

вибрати інтернет-архів, з якого робиться інсталяція. Варіант 0-cloud,  що пропонується за умовчанням, як 

правило, працює цілком задовільно. Після цього треба у списку вибрати необхідний пакет. Якщо цей пакет 

використовує інші, яких немає  на комп’ютері, вони будуть інстальовані автоматично. 

Після того, як пакети інстальовані, вони зберігаються на комп’ютері, але для роботи з ними під час 

сеансу їх необхідно підключати, використовуючи функцію library. Усі об’єкти, створені або завантажені під 

час сеансу роботи з R і не видалені спеціальною інструкцією, зберігаються у робочому просторі. Наприкінці 

сеансу R запитує, чи зберігати робочий простір на диску: Save workspace image? Якщо вибрати збереження, 

то цей робочий простір буде відновлено на початку наступного сеансу. Такою можливістю варто 

користуватись дуже обережно, оскільки «старі» об’єкти можуть спотворювати роботу R у новому сеансі. 

Зберігати робочий простір доцільно лише в тому випадку, коли є необхідність наступного разу продовжити 

роботу з того самого місця, на якому була закінчена робота попереднього разу. 

Корисні сайти, списки посилань і документація по пакету R 

– http://www.r-project.org/ — сайт проекту; 

– http://cran.r-project.org/ — CRAN; 

– https://stat.ethz.ch/pipermail/r-help/ — список посилань R-help; 

– http://finzi.psych.upenn.edu/nmz.html — пошук в матеріалах по R; 

– http://www.statmethods.net/index.html — хороший довідник ресурс; 

– http://zoonek2.free.fr/UNIX/48_R/all.html — довідник по R; 

– http://pj.freefaculty.org/R/Rtips.html — поради щодо використання R. 

 

Результати чисельного моделювання біосенсора на гексагональній решітці  

у вигляді решітчастих зображень флуоресціюючих пікселів. 

З метою отримання результатів чисельного моделювання кіберфізичних біосенсорних системах на 

гексагональній решітці з використанням диференціальних рівнянь із запізненням вводяться значення 

параметрів моделі біосенсора на гексагональній решітці з використанням диференціальних рівнянь із 

запізненням. У комп’ютерній програмі «Комп'ютерне моделювання решітчастих зображень 

флуоресціюючих пікселів в кіберфізичній біосенсорній системі на гексагональній решітці з використанням 

диференціальних рівнянь із запізненням» визначальними є параметри моделі, їх числові значення, а також 

представлення параметрів та їх числових значень в пакеті R, згідно з табл. 1.  

 

Таблиця 1 

Значення параметрів моделі біосенсора на гексагональній решітці  

з використанням диференціальних рівнянь із запізненням 

№ 

п/п 
Назва параметра моделі 

Числові значення 

параметрів 

Представлення параметрів та їх 

числових значень в пакеті R 

1 Ціле натуральне число, яке 

характеризує кількість 

імунопікселів в гексагональній 

решітці 

4=N  N <- 4#4#16 

2 Константа народжуваності  для 

популяції антигенів 
1min2=  beta <- 2 

3 Ймовірнісна швидкість 

нейтралізації антигенів антитілами g

mL




min
2=  gamma <- 2 

4 Стала смертності антитіл 1min1=f  mu_f <- 1 

5 Щільність антигенів  /8.0=  etha <- 0.8/gamma     #0.01184/gamma 

6 Швидкість, з якою популяція 

антигенів прагне до деякої межі 

насичення 
g

mL


 min

5.0=  delta_v <-  0.5  #0.035 #0.7 

7 Швидкість, з якою популяція 

антитіл прагне до деякої межі 

насичення 
g

mL
f 


min

5.0=  delta_f <-  0.5  #0.0175 #0.2 

8 Постійна запізнення в часі, з якою 

настає імунна відповідь 
0.05τ = , 

0.25τ = , 

0.287τ =  

tau <- 0.05#0.25#0.287 
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Продовження табл. 1 

№ 

п/п 
Назва параметра моделі 

Числові значення 

параметрів 

Представлення параметрів та їх 

числових значень в пакеті R 

9 Коефіцієнт дифузії 

min
2.0

2nm
D =  D <- 0.2 

10 Відстань між пікселями nm3.0=  Delta <- 0.3 

11 Стала дисбалансу 0>n  n <- 0.9 #1. 

12 Коефіцієнт пропорційності 

інтенсивності флуоресценції до 

кількості контактів між антигенами 

та антитілами 

flk  flk <- 1 

13 Порогове значення, що визначає 

перехід до стану флуоресценції в 

біопікселі 
fl  fluorescence_intensity_threshold <- 1.5 

 

Після введення відповідних значень параметрів моделі імуносенсора на гексагональній решітці з 

використанням диференціальних рівнянь із запізненням, згідно з табл. 1, представлення в пакеті R x64 3.5.2 

отримаємо у вигляді рис. 2. 

 

 
Рис. 2. Представлення в пакеті R x64 3.5.2 математичної моделі імуносенсора на гексагональній решітці з використанням 

диференціальних рівнянь із запізненням та відповідних параметрів згідно з табл. 1. 

 

На рис. 2 також наведено результат введення моделі дискретної динамічної логіки імуносенсора на 

гексагональній решітці з використанням диференціальних рівнянь, яка має вигляд 
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(- ( - ) - ( ) ( )) ( )
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f i j k f i j k i j k i j k

dV t
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V t F t F t F t

dt

    

   

 

 

 (1) 

 

Для математичного моделювання динамічної логіки імуносенсора використовується синтаксис у 

вигляді мови програмування гібридних програм. У імуносенсорі перший рівень гібридних програм є 

динамічною програмою, яка визначається наступною граматикою 
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У формулі (2) t  є еволюційним доменним обмеженням у вигляді формули логіки першого 

порядку 
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(3) 

В результаті зв’язування антигенів з антитілами в імунопікселі відбувається явище флуоресценції. 

Функціонування імунопікселя ),,( kji  визначається двома станами. А саме, 
lf

s  є станом флуоресценції та 

lfnon
s  є одним із нефлуоресцентних станів.  

Інтенсивність флуоресценції пропорційна кількості контактів між антигенами та антитілами, тобто 

)()( ,,,, tFtVk kjikjifl . Припускається, що піксель ),,( kji  знаходиться у стані флуоресценції, якщо  

flkjikjifl tFtVk ≥)()( ,,,, , (4) 

У формулі (4) 0>fl  є деяким пороговим значенням зв’язування, за якого відбувається явище 

флуоресценції. 

Проаналізовано тривалу поведінку моделі (1) при 05.0= , 25.0= , 287.0=  з набором значень 

параметрів, які представлені вище (рис. 3). Спостерігаємо якісні зміни поведінки імунопікселів та моделі в 

цілому. 

 

  
а 

  

б 

  
в 

Рис. 3. Зображення флуоресценціюючих пікселів системи (1) при а – 05.0= , б – 25.0= , в – 287.0=  

 

Детальний опис математичної моделі біосенсора з використанням диференціальних рівнянь із 

запізненням представлено в роботах [16–20]. Дослідження стійкості моделі імуносенсора та кіберфізичної 

системи з використанням диференціальних рівнянь із запізненням в пакеті R наведено в роботах [21, 22]. 

Висновки. Описано пакет R, як середовище програмування для статистичного аналізу даних. 

Представлено фрагмент роботи з досліджуваним пакетом, наведені посилання на корисні сайти, списки 

посилань і документація по пакету R. У роботі проведено комп'ютерне моделювання контактів антигенів з 
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антитілами в кіберфізичних імуносенсорних системах на прямокутній решітці з використанням 

диференціальних рівнянь із запізненням за допомогою пакету R. Отримані результати мають визначальне 

значення під дослідженні стійкості моделі імуносенсора. При цьому враховується наявність колоній 

антигенів та антитіл, що локалізовані у пікселях, а також дифузію колоній антигенів між пікселями.  
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МЕТОД РОЗПІЗНАВАННЯ РИСУНКА ВЕН ДОЛОНІ  

ЗА КЛЮЧОВИМИ ТОЧКАМИ 
 
В роботі здійснено порівняльний аналіз кількох методів ідентифікації людини за малюнком вен долоні і 

обрано метод із найкращими характеристиками. Проведено аналіз критичних точок венозного малюнка (мінуцій). 
Для оптимального зняття даних впроваджено нову методику сканування руки із використанням фіксаторів, що 
дозволяє до мінімуму скоротити зсув малюнка вен досліджуваної особи і полегшує його порівняння із шаблонним. 
Для скелетизації бінарного зображення обрано метод шаблонів, який дозволяє швидше обробити дані й отримати 
матрицю даних – координати мінуцій та їх тип. 

Ключові слова: венозний малюнок , бінаризація, скелетизація зображення, мінуції.  
 

H.M. NOVITSKII, S.M. ZLEPKO, L.H. KOVAL, V.O. HOMOLINSKYY 
Vinnytsia National Technical University 

  

THE RECOGNITION METHOD OF THE PALM VEIN PATTERNS BY THE KEY POINTS 
 

In this work was implemented the comparative analysis of several methods of identification of the person by the palm vein 
patterns and the method with the best characteristics was selected. The analysis of the critical points of the venous pattern (minutiae) was 
implemented. For optimal data maintenance, a new method of the palm scanning with the usage of retainers is introduced, which minimizes 
the displacement of the vein patterns of the investigated person and makes it easier to compare with the template pattern. To skeletonize a 
binary image, a template method is selected that allows you to process the data faster and retrieve the data matrix with the coordinates of 
the minutiae and their types. 

Keywords: venous drawing, binarization, skeletonization of the image, minutiae. 

 

Вступ 

Біометрична ідентифікація у розрізі зі зростаючими вимогами до безпеки доступу до певних 

ресурсів, інформації та матеріальних об’єктів все частіше використовується для ідентифікації особистості за 

окремими специфічними біометричними ознаками (ідентифікаторами), які є властивими конкретній особі. 

Найбільш поширеними методами біометричної ідентифікації особистості є сканування райдужної оболонки 

ока і відбитків пальців, які є основними у 2/3 від усіх систем ідентифікації.  

Біометрична ідентифікація за малюнком вен руки – це відносно нова технологія у сфері біометрії, 

яка базується на інфрачервоному скануванні вен із подальшим цифровим обробленням. Ця технологія була 

розроблена для використання в системі охорони здоров’я, щоб допомогти лікарям знайти у пацієнтів вени 

для ін’єкційних маніпуляцій. Але враховуючи те, що структура вен у кожної людини індивідуальна, ця 

технологія викликала інтерес фахівців з ідентифікації, як більш надійна відносно технології ідентифікації за 

відбитком пальця, оскільки відтворити модель кровоносної системи неможливо [1]. 

Малюнок вен зчитується із зовнішнього боку долоні або кисті руки за допомогою інфрачервоної 

камери і дозволяє отримати достатньо чітке зображення кровоносних судин, таке, що навіть відносно 

невеликі порізи чи бруд на поверхні шкіри не перешкоджають успішній реєстрації особи. Поглинаючи 

випромінювання, відновлений гемоглобін переносить кисень венами і скорочує ступінь відбиття та 

відображення малюнка вени у вигляді чорного унікального візерунка. Далі отримане зображення 

обробляється, і залежно від розташування вен на руці формується цифрова згортка [2]. 

Переваги методу: 

1) висока достовірність отриманих результатів; 

2) відсутність необхідності прямого контакту з пристроєм, що здійснює сканування; 

3) висока ступінь захищеності – рисунок неможливо отримати від людини «на вулиці», а у випадку 

використання муляжу кисті малюнок вен не буде зчитаний інфрачервоною камерою; 

Недоліки методу: 

1) недопустиме засвічення сканера сонячними променями і променями галогенних ламп; 

2) вплив деяких захворювань, наприклад артриту, на прийняття рішення [1; 3]. 

Експериментальна частина 

Після аналізу існуючих теоретичних та експериментальних даних виявлено, що для підвищення 

точності методу слід використовувати пристрій сканування із системою, що запобігає засвічення області 

сканування видимим світлом чи іншим джерелом, що може спотворити дані для ідентифікації. За 

рекомендацією виробників сканерів рисунка судин, мінімальне значення контрасту зображення малюнка вен 

становитиме не менше 0,125, що сприяє якісній обробці і аналізу зображення, а отже, підвищується точність 

біометричної ідентифікації. 

На зображенні венозного малюнку долоні присутні наступні три області: область закінчення 

судини, область роздвоєння (розгалуження на дві частини), область вигину судини (табл. 1).  

Закінченням називається область рисунка, в околі якої судина переривається через вихід судини з 

реєстрованого фрагменту тканин. 


